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Supply Chain Disruptions During COVID-19
Pandemic Uncover Differences in Keratinocyte
Culture Media

Mary C. Moran1,2,3, Eleanor M. Pope1,3, Matthew G. Brewer1 and Lisa A. Beck1
Various culture media are used to propagate keratinocytes (KCs) in vitro. The COVID-19 pandemic resulted
in supply chain shortages necessitating substitutions to standard laboratory protocols, which resulted in
many laboratories having to use culture media different from those they typically use. We screened
available media on the KC line N/TERT2G and found that biological responses varied considerably across
three culture media: KC serum-free media, KC growth medium 2, and defined media. We observed qual-
itative and quantitative differences in proliferation; KCs cultured in defined media had significantly lower
proliferative capacity. KC differentiation was assessed by western blot for CLDN1, occludin, cytokeratin-10,
and loricrin. Elevated expression of differentiation markers was observed in cells cultured in either KC
growth medium 2 or defined media compared with those in cells cultured in KC serum-free media. KC
barrier function was measured by transepithelial electrical resistance. KCs cultured in KC growth medium 2
and defined media developed significantly higher transepithelial electrical resistance than those cultured in
KC serum-free media, and when treated with IL-4 and IL-13 or IL-17A, we observed variable responses. H&E
staining on day 5 -post-differentiation showed greater epithelial thickness in KCs cultured in defined media
and KC growth medium 2 than in those cultured in KC serum-free media. These findings show that the
choice of culture media impacts the biological response of KCs in a manner that persists through differ-
entiation in the same media.
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INTRODUCTION
Within the field of epidermal biology, various culture media
are used to propagate keratinocytes (KCs). Although the same
media is commonly used within a laboratory, supply chain
disruptions that occurred throughout the COVID-19
pandemic required our laboratory and laboratories around
the globe to identify substitutions for many standard pro-
tocols. We found that the use of alternative KC culture media
gave us highly variable results in the immortalized KC line,
N/TERT2G (Dickson et al., 2000; Moran et al., 2021).

Differences in cell behavior based on culture media have
been observed by other groups. Broadbent et al. (2020) found
that the type of media used for differentiation and mainte-
nance of airway epithelial cells impacts experimental results,
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including morphology, epithelial integrity, and response to
viral infection. Zorn-Kruppa et al. (2016) also commented on
KC characteristics altered by the propagation media. Key
differences to note in these studies include that (i) primary
KCs were used, (ii) comparison was performed with propa-
gation media different from the one we studied (e.g., KC
growth medium 2 [KGM2], DermaLife, and EpiLife; some of
these media and supplements were back ordered so we were
unable to include them in our study), and (iii) they used a
protocol for KC differentiation (high calcium added to the
culture media rather than differentiation media), which is not
commonly used.

We sought to assess relevant biological responses (i.e.,
proliferation, protein expression, barrier function, etc.) of KCs
cultured in different media. Even though researchers may be
aware that cell behavior may vary with media composition,
we hoped to share the significant differences that can be
observed among culture media and further highlight that
media is not interchangeable.

In this study, we assessed the question of whether the
choice of culture media affects critical aspects of KC
biology. We measured several characteristics of the KC cell
line N/TERT2G, which were propagated in three routinely
used culture media: KC serum-free media (KSFM) (number
17005042, Gibco, Waltham, MA), KGM2 (number
C-20211, PromoCell, Heidelberg, Germany), and defined
media (number 10744019, Gibco) (Table 1). We focused on
four KC assays: proliferation, differentiation marker
expression, barrier function, and susceptibility to viral
infection (Figure 1).
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Table 1. Media Composition

Media Type Vendor
Catalog
Number

Known Supplements Added by
Vendor (Concentration)

Supplements Added by Our
Laboratory (Concentration)

Calcium
Concentration

(mM)

Keratinocyte Serum-Free

Medium (KSFM)

Gibco 17005042 BPE (0.2% v/v)

EGF (5 ng/ml)

Penicillin (10 units/ml)

Streptomycin (10 mg/ml)

Amphotericin B (500 ng/ml)

0.09

KGM2 PromoCell C20111 BPE (0.4% v/v)

EGF (0.125 ng/ml)

Insulin (5 mg/ml)

Hydrocortisone (0.33 mg/ml)

Epinephrine (0.39 mg/ml)

Transferrin (10 mg/ml)

CaCl2 (0.06 mM)

Penicillin (10 units/ml)

Streptomycin (10 mg/ml)

Amphotericin B (500 ng/ml)

0.06

Defined media Gibco 10744019 No information was provided on

supplements

Penicillin (10 units/ml)

Streptomycin (10 mg/ml)

Amphotericin B (500 ng/ml)

0.09

EpiLife Cascade

Biologics

MEPI500CA BPE (0.2% v/v)

EGF (0.2 ng/ml)

Insulin (5mg/ml)

Hydrocortisone (0.18 mg/ml)

Transferrin (5 mg/ml)

CaCl2 (0.06 mM)

Penicillin (10 units/ml)

Streptomycin (10 mg/ml)

Amphotericin B (500 ng/ml)

0.06

DermaLife LifeLine Cell

Technology

BPE (0.4%)

Insulin (5 mg/ml)

Hydrocortisone (0.08 mg/ml)

Epinephrine (0.33 mg/ml)

Transferrin (5 mg/ml)

CaCl2 (0.05 mM)

TGFa (0.5 ng/ml)

L-glutamine (6 mM)

Penicillin/streptomycin (100 mg/ml)

Abbreviations: BPE, bovine pituitary extract; CaCl2, calcium chloride; KGM2, keratinocyte growth medium 2; KSFM, keratinocyte serum-free media.
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RESULTS AND DISCUSSION
When propagating N/TERT2G in KSFM, KGM2, and defined
media, we observed similar cell morphology but differences
in how quickly culture flasks reached confluency (Figure 2a).
Figure 1. Schematic of cell culturing and experimental methods. N/TERT2G cells

Once they reached 30% confluency, cells were plated at equal numbers in 96-w

transwells for TEER assays, or 24-well plates for western and infection assays. In

transwells) and were switched to DMEM media containing calcium (1.8 mM) to

KGM2, keratinocyte growth medium 2; KSFM, keratinocyte serum-free media; T

JID Innovations (2022), Volume 2
To quantify changes in proliferation across different media,
we used the Click-iT EdU Proliferation Assay. N/TERT2G cells
were plated in 96-well plates (28,000 cells/well), and after 24
hours, 10 mM 5-ethynyl-20-deoxyuridine was added to each
were cultured in different media, including KSFM, KGM2, and defined media.

ell plates for proliferation assays, 6.5 mm transwell inserts in 24-well plates

all assays, cells reached confluency 48 hours after plating (24-well pates/

initiate differentiation. The Schematic was created using BioRender.com.

EER, transepithelial electrical resistance.

http://BioRender.com


Figure 2. Propagation of KCs in KGM2 and defined media leads to greater barrier integrity and epithelial thickness than in KSFM. (a) Cells were cultured in

KSFM, KGM2, or defined media. Cell morphology was similar across all media. Bar ¼ 200 mm. (b) Proliferation was measured in undifferentiated cells cultured

in KSFM, KGM2, or defined media using the Click-iT EdU assay 6 and 24 hours after addition of EdU (n ¼ 3 experiments). Data were analyzed using Friedman

test with Dunn’s posthoc test (pairwise). Cells were cultured in KSFM, KGM2, or defined media, grown to confluency, and switched to DMEM media containing

calcium (1.8 mM) to initiate differentiation. (c) TEER was measured for 8 days after differentiation (n ¼ 5 experiments). Data were analyzed using Friedman test

with Dunn’s posthoc test (pairwise) comparing KSFM versus KGM2 (*) or KSFM versus defined media (#). (d) Membranes were removed from transwells on D5,

formalin fixed, processed, embedded, sectioned, and stained for H&E. Bar ¼ 50 mm. (e) Epithelial thickness was measured across five representative images per

media type; data were analyzed with Kruskal‒Wallis test with Dunn’s posthoc test (unpaired). Significance: *#P < 0.05, **P < 0.01, ***P < 0.001. Data are

presented as median (Q1, Q3). D, day; EdU, 5-ethynyl-20-deoxyuridine; hr, hour; KC, keratinocyte; KGM2, keratinocyte growth medium 2; KSFM, keratinocyte

serum-free media; Q, quartile; TEER, transepithelial electrical resistance.
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well and incubated for 6‒24 hours (Figure 1). Before adding
the 5-ethynyl-20-deoxyuridine, we observed decreased con-
fluency of cells cultured in defined media, whereas con-
fluency was comparable for cells cultured in KSFM and
KGM2 (data not shown). This finding was confirmed by the 5-
ethynyl-20-deoxyuridine fluorescent readout, which showed a
significant decrease in the proliferative capacity of N/
TERT2G cells grown in defined media compared with those
grown in KSFM (P < 0.05) (Figure 2b). In all media, we
observed increased proliferation from 6 to 24 hours; how-
ever, the degree of this was lower in cells cultured in defined
media (Figure 2b).

As KCs differentiate, their proliferative capacity decreases,
and they form tight junctions, which are critical for estab-
lishing an epithelial barrier. Transepithelial electrical resis-
tance (TEER) is a widely accepted and quantitative measure
of tight junction function, where higher TEER values indicate
greater barrier function. N/TERT2G cells (75,000 cells/well)
were plated in transwells (6.5 mm insert, 0.4 mm polyester
membrane, Costar, Corning, NY) and grown to confluency
(Figure 1). TEER was measured before inducing differentia-
tion (day 0) and every day after (days 1‒8), with media re-
placements performed every 2 days. Notably, continued
growth in KSFM, KGM2, and defined media (without
switching to DMEM) did not result in increased TEER (data
not shown). After inducing differentiation with DMEMmedia,
we observed that KCs cultured in KGM2 (P < 0.01) or defined
media (P < 0.05) rapidly developed significantly higher TEER
than cells initially cultured in KSFM (Figure 2c). This in-
dicates that the initial propagation of KCs in defined media or
KGM2 promotes greater barrier function of differentiated
cells. H&E staining showed greater stratification and epithe-
lial thickness (P < 0.001) in cells that had been cultured in
defined media or KGM2 than in those cultured in KSFM,
which also may explain the increased level of TEER observed
with defined media and KGM2 (Figure 2d and e). We could
not delineate from the specimens whether the thicker
epidermis was a consequence of taller cells or simply more
layers of cells.

To further understand the characteristics of N/TERT2G cells
grown in these different media, we analyzed the expression
of differentiation markers by western blot analysis (Goleva
et al., 2019). On reaching confluency, KCs were switched
to high calcium DMEM media (1.8 mM) to induce differen-
tiation (Bikle et al., 2012). In undifferentiated KCs, we
observed surprising differences in the expression of the
www.jidinnovations.org 3
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Figure 3. Markers of KC differentiation are significantly impacted by propagation media. Cells were cultured in KSFM, KGM2, or defined media; grown to

confluency; and switched to DMEM media containing calcium (1.8 mM) to initiate differentiation. Cell lysates were (a) collected from Undiff KCs 24 hours after

reaching confluency and (b‒‒e) collected from Diff KCs on D1, D2, and D3 after differentiation. Differentiation markers CK10 and LOR and tight junction

proteins CLDN1 and OCLN were detected by western blot analysis. (f) A representative blot for each protein is provided. Expression was quantified by

densitometry with normalization to b-actin expression. n ¼ 3 experiments. Graphs with <3 points indicate that protein was ND in experiments. Solid bars

indicate Undiff KCs in respective media; open bars indicate KCs that have been switched from respective media to DMEM. Friedman test with Dunn’s posthoc

test (pairwise) of KSFM versus KGM2 or KSFM versus defined media. Significance: *P < 0.05. Data are presented as median (Q1, Q3). CK10, cytokeratin 10; D,

day; Diff, differentiated; hr, hour; KC, keratinocyte; KGM2, keratinocyte growth medium 2; KSFM, keratinocyte serum-free media; LOR, loricrin; ND, not

detected; OCLN, occludin; Q, quartile; Undiff, undifferentiated.
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barrier proteins CLDN1 and occludin (OCLN) and a
commonly used marker of differentiation, cytokeratin-10.
These proteins were below the limit of detection in nearly
all the samples cultured in KSFM, whereas expression was
detected in samples cultured in either KGM2 or defined
media (Figure 3a and f). Undifferentiated cells are reminis-
cent of cells within the stratum basale of the epidermis,
where OCLN and cytokeratin-10 are not typically detected at
the protein level; therefore, it is surprising that we could
detect these proteins in undifferentiated KCs (Fuchs and
Green, 1980; Kirschner et al., 2010). This suggests that KCs
cultured in KSFM have protein expression similar to in vivo
observations, whereas culturing in KGM2 or defined media
may prime cells for differentiation. On differentiation, we
observed earlier and/or greater expression of the differentia-
tion markers and barrier proteins CLDN1, OCLN, and loricrin
in cells that had been cultured in KGM2 or defined media
than in KCs cultured in KSFM (Figure 3b‒f). The expression of
these proteins, although significantly lower in undifferenti-
ated KCs (KSFM) (P < 0.05), became comparable in differ-
entiated cells. These findings reveal that culturing KCs in
different media fundamentally alters the cells in ways that
impact protein expression in both undifferentiated and
differentiated KCs, even after switching to the same media.

The significantly increased barrier function observed in
KCs propagated in defined media or KGM2 (Figure 2b) may
be explained by our western blot findings, in which two
important tight junction proteins, CLDN1 and OCLN, were
JID Innovations (2022), Volume 2
already detected in undifferentiated KCs propagated in
defined media or KGM2 (Figure 3a). Furthermore, the relative
intensity of CLDN1 and OCLN strongly correlated with TEER
values of matched samples (Table 2).

Our laboratory studies atopic dermatitis and frequently
employs the in vitro model of KCs conditioned with type 2
cytokines IL-4 and IL-13 (IL-4/13) to study epidermal biology,
with a focus on barrier development (Figure 4a). We
observed a range of responses to IL-4/13 treatment, with
KSFM-propagated KCs showing an initial drop in TEER (days
2‒3), followed by a significant increase in TEER at later
timepoints (days 5‒8) (P < 0.05). Cells cultured in defined
media showed no significant TEER changes after IL-4/13
treatment. Finally, we observed a modest but significant
decrease in TEER on IL-4/13 treatment in cells that had been
cultured in KGM2 (day 6) (P < 0.05). To test whether this
difference in response to cytokine stimulation was observed
with other cytokines, we treated KCs with the type 3 cytokine
commonly observed in psoriasis, IL-17A. Similar to IL-4/13
stimulation, we saw a range of responses depending on
which media KCs had been propagated in (Figure 4b). KCs
propagated in KSFM showed a transient enhancement in
TEER (days 2‒3), followed by a significant decrease in TEER
(days 4‒5) (P < 0.05). KCs propagated in KGM2 also resulted
in a significant decrease in TEER from day 4 to day 8 (P <
0.01‒0.05). Similar to treatment with IL-4/13, treatment with
IL-17A had no significant impact on TEER in KCs propagated
in defined media, although a modest decrease was observed.



Table 2. Barrier Function Correlates with the
Expression of Tight Junction Proteins

Media
Tight Junction

Protein
Pearson

r
95% Confidence

Interval P-Value

KSFM CLDN1 0.921 0.435e0.992 0.009

KSFM OCLN 0.951 0.613e0.995 0.004

KGM2 CLDN1 0.948 0.591e0.994 0.004

KGM2 OCLN 0.984 0.855e0.998 0.0004

Defined

media

CLDN1 0.636 ‒0.363 to 0.955 0.175

Defined

media

OCLN 0.985 0.865e0.998 0.0003

Abbreviations: KGM2, keratinocyte growth medium 2; KSFM,
keratinocyte serum-free media; OCLN, occludin; TEER, transepithelial
electrical resistance.

TEER and relative intensity of tight junction proteins CLDN1 and OCLN,
as measured by western blot quantification, were analyzed for correlation
using the Pearson correlation test over the course of 3 days of
differentiation. n ¼ 2 matched sample experiments.
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This highlights that the culture media used may change the
KC inflammatory response. It is possible that culturing KCs in
these different media results in differential expression of
cytokine receptors, which may contribute to the variable ef-
fects of IL-4/13 and IL-17A on KC barrier function.

We have previously shown the state of KC differentiation
impacts susceptibility to infection with vaccinia virus (Moran
et al., 2021). Because western blot and TEER findings suggest
differences in the kinetics of differentiation in cells propa-
gated in defined media or KGM2 from those propagated in
KSFM media, we evaluated whether susceptibility to viral
infection differed. N/TERT2G cells were grown to conflu-
ence, and cells were infected with a low multiplicity of
infection of vaccinia virus 1 or 2 days after differentiation.
Undifferentiated KCs were similarly infected. We observed
comparable infection kinetics over the course of differentia-
tion across the three media. Undifferentiated KCs were most
resistant to infection, day 1 differentiated KCs were more
susceptible, and day 2 differentiated KCs became less sus-
ceptible to infection. Infection was significantly greater in
Figure 4. KC propagation media significantly impact barrier responses to cytokin

to confluency; and switched to DMEM media containing calcium (1.8 mM) to i

experiments) or (b) 50 ng/ml of IL-17A (n ¼ 4 experiments) at the time of differe

comparing KSFM with KSFM þ cytokines (&) or KGM2 with KGM2 þ cytokines

$,&P < 0.05, $$P < 0.01, and $$$P < 0.001. Data are presented as median (Q1,

keratinocyte serum-free media; Q, quartile; TEER, transepithelial electrical resist
undifferentiated cells (KGM2) than in KSFM (P < 0.05),
which may be partially due to the more differentiated-like
nature of KCs cultured in KGM2, which is supported by the
western blot analysis showing increased levels of differenti-
ation markers in KCs grown in this media (Figure 3a). There
were no significant differences in infection among the day 1‒
or day 2‒infected cells across the media, indicating that the
overall kinetics of susceptibility is similar among the different
media types (Figure 5).

The use of different culture media fundamentally alters KCs
in a manner that persists even after switching cells to the
same media (DMEM) (Table 3). These studies show that cul-
ture conditions are able to induce lasting changes in KCs that
impact numerous biological functions. Although under-
standing which components of each media are responsible
for such changes is critically important, the formulations of
these media are in part proprietary, and therefore we are
unable to test individual components. Our results highlight
specific differences between commonly used and commer-
cially available media, so that laboratories may be more
aware of what results to expect depending on their media of
choice. These findings may also support why specific exper-
imental results may not be repeatable across laboratories if
different culture media are being used. This observation
should motivate the field to be precise in our experimental
methodology reporting, particularly regarding which media
and supplements are used and from which vendor.
MATERIALS AND METHODS
Cell cultures

N/TERT2G cells were provided by Ellen H. van den Bogaard and

grown to 30% confluency as previously described (Dickson et al.,

2000; Moran et al., 2021; Smits et al., 2017). Cells were cultured

in one of the three media: KSFM (number 17005042, Gibco), KGM2

(number C-20211, PromoCell), and defined media (number

10744019, Gibco). N/TERT2G cells were switched to DMEM media

supplemented with 4 mM glutamine and 1.8 mM calcium ion to

induce differentiation. Days after differentiation refers to the number

of days since exposure to DMEM. Representative images were taken
e stimulation. Cells were cultured in KSFM, KGM2, or defined media; grown

nitiate differentiation. Cells were treated with (a) 50 ng/ml of IL-4/13 (n ¼ 3

ntiation, and TEER was measured for 8 days after differentiation. Paired t-test

($); black points indicate matched untreated media controls. Significance:

Q3). D, day; KC, keratinocyte; KGM2, keratinocyte growth medium 2; KSFM,

ance.
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Figure 5. Viral infection kinetics are similar across KSFM, KGM2, and

defined media culture media. Cells were cultured in KSFM, KGM2, or

defined media; grown to confluency; and switched to DMEM media

containing calcium (1.8 mM) to initiate differentiation. Cells were infected

with a low MOI (0.0001) of vaccinia virus while Undiff on D1 after

differentiation or D2 after differentiation. Plates were stained with crystal

violet 48 hours after infection to visualize plaque formation. ImageJ was used

to calculate the percentage of the monolayer within each well that was

cleared by plaques (n ¼ 4‒6 experiments). Wilcoxon matched-pairs signed

rank test for Undiff KSFM versus KGM2. Significance: *P < 0.05. Data are

presented as median (Q1, Q3). D, day; KGM2, keratinocyte growth medium

2; KSFM, keratinocyte serum-free media; MOI, multiplicity of infection; Q,

quartile; Undiff, undifferentiated.

Table 4. Western Blot Antibodies

Antibodies Company Dilution

Anti-CLDN1 (519000) Invitrogen 1:1,000

Anti‒b-actin (C4) HRP Santa Cruz 1:5,000

Anti‒keratin 10 (Poly 19054) BioLegend 1:1,000

Anti-loricrin (Poly 19051) BioLegend 1:1,000

Anti-occludin (OC3F10) Invitrogen 1:500

Anti-mouse IgG HRP (NA931V) Sigma-Aldrich 1:5,000

Anti-rabbit IgG HRP (NA934V) Sigma-Aldrich 1:5,000

Abbreviation: HRP, horseradish peroxidase.
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at �140 magnification using the EVOS XL Core Imaging System

(Thermo Fisher Scientific, Waltham, MA).

Proliferation assay

N/TERT2G cells were plated in 96-well plates at 28,000 cells/well.

After 24 hours, 10 mM 5-ethynyl-20-deoxyuridine was added to each

well and incubated for 6 or 24 hours. Proliferative capacity was

assessed by the Click-iT EdU Proliferation Assay for Microplates

(C10499, Invitrogen, Waltham, MA), and the protocol was followed

as written in the product information sheet.

Western blot analysis

N/TERT2G cells were plated in 24-well plates at 75,000 cells/well.

Cell lysates (RIPA buffer containing protease and phosphatase in-

hibitors with 0.2% SDS) were collected from undifferentiated cells
Table 3. Summary of Key Findings

Assay KSFM KGM2 Defined
Figure
Number

Proliferation [ [ Y 2b

TJ barrier function (TEER) [ [[[ [[ 2c

Epithelial thickness [ [[ [[ 2d and e

Undifferentiated condition
(CLDN1, OCLN, CK10)

Y [[ [[ 3a

Differentiated condition (D1)
(CLDN1)

Y [ [[ 3e and f

Differentiated condition
(D2, D3)

[ [ [ 3e and f

Response to type 2 cytokines [ [ [ 4a

Response to type 3 cytokines YY YY Y 4b

Pattern of viral infection [ [ [ 4

Abbreviations: D, day; CK10, cytokeratin 10; KGM2, keratinocyte growth
medium 2; KSFM, keratinocyte serum-free media; OCLN, occludin; TEER,
transepithelial electrical resistance; TJ, tight junction.

JID Innovations (2022), Volume 2
and from cells on days 1, 2, and 3 after differentiation. Samples were

run on Invitrogen NuPAGE 4‒12% Bis-Tris gels and transferred to a

polyvinylidene fluoride membrane (Bio-Rad Laboratories, Hercules,

CA). Membranes were probed with the antibodies provided in

Table 4. Antibodies (Table 4) were detected using SuperSignal West

Pico PLUS Chemiluminescent Substrate (Thermo Fisher Scientific).

Relative protein expression was determined by densitometry calcu-

lated using ImageJ software (National Institutes of Health, Bethesda,

MD). Samples were normalized to b-actin expression and protein

content (Pierce BCA Protein Assay Kit, Thermo Fisher Scientific).

TEER/epithelial thickness

TEER measurements were done as previously published (De

Benedetto et al., 2011). Measurements of TEER were taken for up

to 8 days after the initiation of differentiation and exposure to type 2

cytokines IL-4 and IL-13 at 50 ng/ml of each (number 574004 and

571104, BioLegend, San Diego, CA) or type 3 cytokine IL-17A

(317ILB, R&D Systems, Minneapolis, MN). To measure epithelial

thickness, membranes were cut from transwells on day 5 after dif-

ferentiation and fixed in formalin. University of Rochester Medical

Center Pathology processed, embedded, sectioned, and stained the

membranes for H&E. Representative images were taken using the

EVOS XL Core Imaging System (Thermo Fisher Scientific) at �560.

Epithelial thickness was quantified at six equally distributed loca-

tions across five representative images per media type using ImageJ

software. The straight-line tool was used to span the thickness of the

layers and was then measured using the Analyze -> Measure

function.

Vaccinia virus infection assay

N/TERT2G cells were plated at a density of 150,000 cells/well in a

24-well plate. Cells were infected at a low multiplicity of infection

with the western reserve strain of vaccinia virus (multiplicity of

infection of 0.0001) while undifferentiated 1 day after differentiation

(day 1) or 2 days after differentiation (day 2). Crystal violet was

added to the cells 48 hours after infection. ImageJ software was used

to calculate the percentage of the monolayer within each well that

was cleared by plaques. To do this, each well was selected with the

region of interest tool (circle), and the image was duplicated (right

click, duplicate). The total area of the circle was determined using

Analyze -> Measure. Next, the outside of the circle was cleared

using the Edit -> Clear Outside command, then the Threshold

function was applied to the image so that the cleared monolayer

(plaques) was white: Image -> Adjust -> Threshold -> Apply.

Finally, all areas considered to be plaques were selected using the

Edit -> Selection -> Create Selection, and the selection was inverted

using the Make Inverse function. The area covered by plaques was

measured with the Analyze -> Measure, and the area covered in
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plaques was divided by the total area to get a percentage of

monolayer cleared.

Statistical analysis

Statistics were run using GraphPad Prism (GraphPad Software, San

Diego, CA). The Friedman test with Dunn’s posthoc test for multiple

pairwise comparisons was used to compare proliferation among the

media (KSFM vs. KGM2, KSFM vs. defined media, and KGM2 vs.

defined media) at both 6 and 24 hours, respectively. The Friedman

test with Dunn’s posthoc test (pairwise) using KSFM as the control

group (KSFM vs. KGM2, KSFM vs. defined media) was run on each

day of differentiation (day 0‒8) in which TEER was measured. The

Kruskal‒Wallis test with Dunn’s posthoc test for multiple compari-

sons (unpaired) was used to compare epithelial thickness among the

three media (KSFM vs. KGM2, KSFM vs. defined media, KGM2 vs.

defined media). For each protein and at each day of differentiation

(undifferentiated, day 1, day 2, day 3), the Friedman test with Dunn’s

posthoc test (pairwise) using KSFM as the control group (KSFM vs.

KGM2, KSFM vs. defined media) was used to test for differences in

protein expression. Correlation between TEER and tight junction

protein expression (CLDN1 and OCLN) across 3 days of differenti-

ation was assessed using the Pearson correlation test. On each day of

differentiation (day 0‒8), a paired t-test was run comparing media

alone (KSFM, KGM2, or defined media) with media with cytokines

(either IL-4/13 or IL-17) to test whether treatment with cytokines

significantly changed TEER within each media. The Wilcoxon

matched-pairs signed rank test was used to compare infection in

undifferentiated KC cultured in KSFM or KGM2. No statistics were

run on defined media of undifferentiated KCs because there was

only n ¼ 2. Kruskal‒Wallis tests with Dunn’s posthoc test (unpaired)

comparing KSFM with KGM2, KSFM with defined media, and

KGM2 with defined media were run on days 1 and 2 of differenti-

ation and showed no significant differences in infection.
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